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Introduction

Welcome to Command: Aces of the Deep. This
latest version of the renowned Aces of the Deep U-
boat simulation combines the updated CD version
and its on-line manual with the full Expansion Disk
(including its Mediterranean and Type XXIgameplay).
Most importantly, this version brings you all new
high-resolution SVGA graphics, exciting new deck
gun action, and, for Windows 95 users, breakthrough
speech recognition technology from IBM. Now you
can speak your combat commands, and experience a
whole new level of gaming immersion and intensity.

About This
Manual

Your game packet includes three manuals. Here's
where to go for what:

This Command:Aces of the Deep booklet tells you
how to install and configure your game for both
Windows 95 and Windows 3.1. It also shows you how
to use the new speech recognition (Windows 95 only)
and deck gun features.

The Aces of the Deep manual launches you with a
detailed Tutorial. Its “Ashore” section describes how
to navigate the game menus and the sophisticated
on-line manual, and its At Sea” section details the
many game commands you'll use to command your U-
boat in action.

The Aces of the Deep Expansion Disk manual
describes additional features: Mediterranean missions,
the Type XXI U-boats, and using the Type XXI's sonar
and radar.

NOTE: For Installation, Troubleshooting, or
Customer Service information, refer to this
Command:AOD booklet only. Some of this infor-
mation in the other manuals is now outdated.

For additional install, troubleshooting, or
gameplay updates, refer to the README file in the
Sierra Program Group or folder.




Installing and Starting
the Game

Installing for Windows 95
1. Start Windows 95.
2. Insert the Command CD into the CD-ROM drive.

3. When the Command install screen appears, fol-
low the on-screen instructions.

Starting the Game - Windows 95
1. Start Windows 95.
2. Insert the Command CD into the CD-ROM drive.

3. dlick on the Start Game option when it appears.

Installing for Windows 3.1
1. Start Windowvs 3.1.
2. Insert the Command CD into the CD-ROM drive.

3. From the Program Manager FILE menu, select
RUN.

4. In the RUN window, type d:\setup and press
[Enter] (assuming d is your CD-ROM drive name).

5. Follow the on-screen instructions.

Note: Commandwillinstall the latest Microsoft Win32$
and WinG extensions to Windows 3.1, if you don‘t
have them already. They improve your Windows pro-
cessing and graphics performance.

Starting Game - Windows 3.1

—

Start Windows 3.1.

2. Insert the Command CD into the CD-ROM drive,
3. Open the Sierra Program Group.
. :

Double-click on the Command icon to start the
game.

Additional Windows Setup

During installation, TEST SYSTEM checks to make
sure your computer can run the game correctly. If you
have trouble starting Command after installing it in
Windows 3.1, check the Troubleshooting section on
page 11. Additional game information may be pre-
sented in the Command README file.

After game installation, the Setup & Uninstall
program in the Sierra Program Group lets you re-
install the game, re-test your computer, uninstall the
game, register, or view detailed Support and Trouble-
shooting information. To start it, just double-click on
the Setup & Uninstall icon.




Note: Micro-
phone not
included.
Please consult
on-line
manual for a
list of recom-
mended mi-
crophones.
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Speech Recognition
Commands (Windows 95 only)

In Command: Aces of the Deep for Windows 95,
most of the U-boat operations you normally would
control using the keyboard or mouse can now also be
performed using your voice. Connect a microphone
to your sound card and calibrate it, select “Speech
Recognition On* from the Options Menu while at sea,
and you are ready to go.

Calibrating Your Microphone

1. Plug the microphone into your PC’s sound card
following manufacturer’s directions.

2. Start Command:AOD. From the File Menu, select
“Set Microphone Threshold.”

3. Follow the on-screen instructions. Note: Try to
calibrate under external noise conditions similar
to those you expect to encounter when playing
the game.You may need to recalibrate from time
to time, particularly if ambient noise conditions
near your computer change.

Using Speech Recognition

Once your mike is calibrated, start Command:
AOD and enable the feature. Just select “Speech
Recognition On” from the Options Menu while at sea
(press [Ctrl]+[O] or select Options from the Menu Bar).

The speech recognition software employed in
Command:AOD (IBM's VoiceType) already recognizes
the voice commands listed on the following pages. It
does not have to be “trained.”

Before speaking, press the Microphone icon or
the [M] key. Speak the commands naturally, with the
microphone about one inch from your lips.

Voice Commands

Once enabled, the speech recognition featurecan
use the following commands. X indicates a variable
where you substitute a numerical value (for meters,
knots, degrees etc.) When speaking numbers, use only
the numbers 0-9, pronouncing 0 as zero. For example
pronounce “Make Depth 150 Meters” as "Make Depth
One Five Zero Meters,” and so forth. You need not
speak leading zerces: eg., say “Nine Degrees,” not
"Zero Zero Nine Degrees.”

Submerged Operations

ALARM! (Crash Dive)

DIVE! DIVE! (Commence dive)

STRAIGHT AND LEVEL (Level off at current depth)

MAKE DEPTH [X X X] METERS (Bring the boat to
ordered depth)

COME TO PERISCOPE DEPTH (Bring the boat to
appropriate depth)

UP PERISCOPE (Raise the Scope and go to it)

DOWN PERISCOPE (Lower the Scope, go to Control
Room)

RIG FOR SILENT RUNNING (Slow to silent speed,
secure loose gear, etc.)

SECURE FROM SILENT RUNNING (Resume speed
preceding Silent Running)

DEPLOY SNORKEL (If your boat has one. Go to
snorkel depth, deploy snorkel, switch to diesels)

STOW SNORKEL (Stow snorkel, switch to electric
motors if underwater)

BLOW ALL TANKS (Emergency surface)
COME TO SURFACE (Come to the surface)
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Maneuvering

ALL AHEAD [ONE THIRD/ TWO THIRDS/ FULL/
FLANK] (Set engine telegraph to given value)

ALL BACK (Put engines in low-speed reverse)

ALL BACK EMERGENCY (Put engines in full-speed
reverse)

ALL STOP (Stop engines)
SET SPEED [X X] KNOTS (Come to ordered speed)

[LEFT/ RIGHT] STANDARD RUDDER (Normal turn
left or right)

[LEFT/ RIGHT] FULL RUDDER (Turn hard to left or
right)

RUDDER AMIDSHIPS (Center the rudder—stop turn-
ing)

NEW COURSE [X X X] DEGREES (Bring the boat to
ordered course)

Operate Weapons and Other Gear
T-D-C (Brings up Torpedo Data Computer)
IDENTIFY TARGET (Describe target)

MARK TARGET (Select current target)

FIRE [X] (Fire given torpedo tube)

MAN [DECK/ A-A] GUN (Prepare gun)

SECURE [DECK/ A-A] GUN (Remove crews from or-
dered guns)

Status Reports

REPORT CONTACTS (Have Sound Operator report
hydrophone contacts)

REPORT WATER IN BILGE (Brings up gauge for water
in the boat)

REPORT COMPRESSED AIR (Brings up Compressed
Air gauge)

REPORT OXYGEN REMAINING (Oxygen gauge)
REPORT BATTERY LEVEL (Battery Level gauge)
REPORT FUEL LEVEL (Diesel Fuel gauge)
REPORT COURSE (Brings up Compass)

REPORT DAMAGE (Go to Damage Report)
REPORT DEPTH (Depth gauge)

REPORT SPEED (Brings up Engine Telegraph and
Speed gauge)

REPORT DEPTH UNDER KEEL (Gives water depth at
current location)

CLEAR (Remove current pop-up gauge from display)

Change Locations
BRIDGE (Go to the Bridge Screen)
BINOCULARS (Use Binoculars)
CHART ROOM (Go to charts)

TORPEDO ROOM (Go to Torpedo Management
Screen)

RADIO ROOM (Go to Radio Room)
CONTROL ROOM (Go to Control Room)
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Operating the Deck Gun
Manually

You may let your crew aim and fire the deck gun
automatically (the default setting), or operate it manu-
ally yourself. To operate the deck gun yourself, first
select “Fire Deck Gun Manually” from the Options
Menu. When you select “Man Deck Gun"” from the
Voice Tube Menu, via hot key [D], or by voice com-
mand, you then open the Deck Gun screen—looking
through the sights of the deck gun.

Simply aim the gun at the vessel you wish to
attack andfire. (Youdonotneedto "select” atarget.)
Click on the horizontal dial to change the gun azi-
muth (direction), and the vertical dial to change its
elevation (barrel angle, and hence range). Hold the
mouse button down to move the gun rapidly in the
indicated direction.

To fire the gun, click on the bright red Fire button
to the right. When the button is dark, the gun cannot
be fired. (It will be dark if the gun is being reloaded,
or is seriously damaged.) Correct your aim by watch-

ing for splashes or explosions. If you see neither of
these after a shot, you are probably aiming high, and
the splash of your falling shot is behind the target.

To change the view magnification, click on the
magnification control on the left.

To go back to automatic deck gun command,
return to the Options Menu and deselect the "Man
Deck Gun” option.

Troubleshodting

Problems you may have running the game are
likely addressed in this section, in the on-line manual,
or in the Command:AOD README file (in the Sierra
Program Group/Folder or on the CD). You can also
check the Sierra BBS or your on-line provider for post-
release information.

Problem: | have installed Command on a compressed
drive, and it does not run.

Possible solution: Command may need more disk
space. Compression software expects to compress
files by a ratio of 2 to 1 or more. However, many
Command files will not compress much. This means
you may need to free up to twice as much space as the
compression software estimates.

Problem: When attempting to launch Command in
Windows 3.1, | keep getting an “Out of Memory”
error message.

Possible solution: Try closing all other programs or
screen savers before launching Command. If that
doesn’t do it, try making a Boot Disk. The Boot Disk
Maker in the Sierra Program Group or Folder will
create an boot disk optimized to run Command.

@ i1
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Simply double-click on the Boot Disk Maker icon, and
follow the on-screen instructions. NOTE - you will
need a blank disk for your A: drive to create a
boot disk.

Problem: My computer has at least 8 megabytes of
memory, but even after creating a boot disk, I still
receive a message saying that | do not have enocugh
memory to run the game.

Possible Solution: Your boot disk may require fur-
ther modifications to load your device drivers cor-
rectly into upper memory. See the “Customizing the
Boot Disk” section, or consult your computer
system manual or manufacturer for assistance.

Problem: | have a SCSI drive and Command does not
work properly.

Possible Solution: There are incompatibilities be-
tween SMARTDRV.SYS and certain SCSl drives. Do not
use SMARTDRV.SYS for Command if you have a SCSI
drive. You may also need to load your ASPI drivers.
For more information on specific drivers, please con-
sult your SCSI controller documentation or hardware
documentation.

Error Messages

General Protection Fault: Try updating both your
Windows Video Driver and your Windows Sound Card
drivers. Contact your video card and sound card
manufacturer for more information.

Not Enough Memory to Run This Application: Try
closing all other programs or screen savers before
launching Command. If that doesn’t do it, try making
a Boot Disk.

Configuring Windows 3.1 Memory

Even if you have the minimum 8MB of RAM,
Command: Aces of the Deep may not run correctly
unless the RAM is configured (set up) correctly for the
game. If Command DOES NOT start correctly, pull
down the Help menu from Program Manager, and
select the About Program Manager option. If Pro-
gram Manager indicates you are low on memory (80%
orbelow), try closing all other applications and screen
savers before starting the game. If that doesn’t work,
try creating a boot disk.

Freeing up Memory

1. If you cannot run Command in Windows 3.1 be-
cause of low memory, try making a Boot Disk, as
described below. Aboot disk is a fast and effective
way of freeing more memory to run the game.

2. If you continue to have problems even with a
boot disk, try customizing the boot disk’s
AUTOEXEC.BAT and CONFIG.SYS start-up files.
See "Customizing the Boot Disk,” below, for
details.

3. Consultyour DOS and memory manager software
documentation for detailed information about
system memory and how to optimize it.

Making a Windows 3.1 Boot Disk

A boot disk is the simplest way to configure your
computer’s memory for running Command. The Boot
Disk Maker in the Sierra program group makes creat-
ing a boot disk easy. Once you have a boot disk, you
just put the boot disk in your floppy drive and restart
the computer to configure its memory correctly.

Although the Boot Disk Maker does a very good
job of configuring most systems, it may not be able to
properly recognize every possible sound card, mouse,
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or disk-controlling device driver. This means that you
might have to make additional changes to the boot
disk to get the program running. If you are having
trouble starting the game, try making a Boot Disk—it
can't hurt. If it does not work, however, proceed to
the “Customizing the Boot Disk” section, below.

You can use the Boot Disk Maker program to
format and create a Command boot disk for your
computer’s A: drive. Before you start, have a blank or
formattable floppy disk for your A: drive ready. (Any
files on it will be erased.)

1. From Windows, double-click on the SIERRA pro-
gram group.

2. Double-click onthe “Boot Disk Maker” iconinthe
Sierra program group.

3. The Boot Disk Maker will guide you through the
process—follow the on-screen prompts carefully
allthe waythrough. Insertthe blank diskette into
your A: drive when prompted. The Boot Disk
Maker will use DOS commands to format the
floppy disk and write all the necessary start-up
files to it.

Using a Boot Disk

The Windows bootdisk you have created contains
a stripped-down version of your usual start-up files.
You must start (or restart) your computer with the
boot disk in the A: drive for it to work. (Note: a boot
disk will work only in the A: drive).

1. Place the boot disk in the A: drive and start the
computer. {If your computer is already running,
exit Windows and restart the system with your
PC’s Reset button, or use [CtrI]+[Alt]+[Del] from
the keyboard.)

2. The computer will start up using the boot disk’s
memory configuration. If necessary, start Win-
dows by typing WIN at the DOS prompt (assuming

the boot disk has not started Windows for you.)
Double-click on the Sierra Program Group, then
double-click on the Command: Aces of the Deep
icon.

Customizing Your Windows 3.1
Boot Disk

To customize a boot disk for your specific system,
you can edit the CONFIG.SYS and AUTOEXEC.BAT
start-up files on a boot disk created by the Boot Disk
Maker, or create a new Boot Disk from scratch.
CONFIG.SYS and AUTOEXEC.BAT are simple text files
that you can edit using your MS-DOS EDIT utility, the
Windows Notepad, or your preferred word processor
in its text-only mode. On your hard drive, these files
tell your computer how to arrange its memory for
normal operation. On the boot disk, these files tell
your computer how to arrange its memory specifically
for running Command.

Warning: Manually altering the CONFIG.SYS and
AUTOEXEC.BAT start-up files can be a trial and error
process. When opening a file to edit, triple-check to
MAKE SURE you are working with the files on your
boot disk in the A: drive. Otherwise, you may change
the CONFIG.SYS and AUTOEXEC.BAT files on your
hard drive instead, which in turn may impair the
normal operation of your system.

(If you prefer to create a boot disk from scratch,
you will need a freshly formatted system diskette for
your A: drive. (See your MS-DOS manual for details on
how to create a system diskette. You can then create
a new CONFIG.SYS and AUTOEXEC.BAT from scratch
right on the boot disk.)

Compare the CONFIG.SYS and AUTOEXEC.BAT
files on your boot disk to the following examples.
Differences may indicate places where you can re-
move a driver, load it into upper memory, or change
a device switch to use less memory. As always, refer to
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your system reference manuals if unsure about any-
thing.

These examples show a “minimum configura-
tion” that will let you run Command on most PCs. The
lines in your start-up files will differ according to your
system’s drivers and directory names, and the version
of MS-DOS you use. (NOTE: Parentheses indicate com-
ments that are NOT part of the file.)

Sample Boot Disk CONFIG.SYS File

DEVICE=CADOS\HIMEM.SYS
DEVICE:C:\DOS\E-MNIBSG.EXE NOEMS

(You may use a different memory manager)
DOS=HIGH,UMB

(Loads DOS into Upper Memory)

FILES=30

BUFFERS=20

BREAK=0ON

LASTDRIVE=Z
DEVICEHIGH=C:\DOS\DBLSPACE.SYS /MOVE

(Only if using DBLSPACE. See “Disk Compression Driv-
ers,” below.)

DEVICEHIGH=CADRWVACDROM.SYS /D:MSCDO001 /P:220
(See “CD-ROM” Drivers, below.)

Sample Boot Disk AUTOEXEC.BAT
file

@ECHO OFF

PROMPT Command Boot Disk $P$G

(Added by Boot Disk Maker)
PATH=CA\WINDOWS

SET COMSPEC=C\COMMAND.COM

(Will use your actual COMMAND.COM location)
C:\DOS\MSCDEX /D:MSCD001

G (Changes to hard drive.)

WIN  (Starts Windows 3.1)

CD-ROM Drivers

To run Command: Aces of the Deep from the CD,
you'll need to include a CD-ROM line in both the
CONFIG.SYS and the AUTOEXEC.BAT files of the boot
disk. Refer to your CD-ROM manual for your specific
details.

The Boot Disk AUTOEXEC.BAT file needs an
MSCDEX line. Depending on your CD-ROM type, it
should look much like one of the following:

CADOS\MSCDEX /D:MSCD0O1
LH C\DOS\MSCDEX /D:MSCD001
LOADHIGH /L:14429 C\DOS\MSCDEX /D:MSCDO0O01

The Boot Disk CONFIG.SYS file needs a CD device
driver line. Depending on your CD-ROM type, itshould
look much like one of the following:

DEVICE=CADRVWCDROMDRV.SYS /D:MSCDQO1 /P:220
DEVICEHIGH /L:14652 =C\DRVACDROMDRV.SYS /D:MSCD001 /P:220
DEVICEHIGH=C\DRV\CDROMDRV.SYS /D:MSCD001 /P:220
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We recommend that you use the latest version
of MSCDEX.EXE to insure the best CD access. As of
this writing, the current version of MSCDEX is 2.23.

Note: If you have a SCSI CD-ROM drive, you may need
to manually load the ASPI drivers in the CONFIG.SYS
file before the computer will recognize your CD-ROM
drive. Consult your hardware documentation.

Disk Compression Drivers

. Ifyou use disk compression on your hard disk, you
mustinclude the correct disk compression driverstate-
ment on your boot disk, or your mouse or other
drivers may not load correctly. The example
CONFIG.SYS shows the correct statement if you are
using the MS-DOS DBLSPACE utility.

If you are using Stacker 3.1 or later, use the
following line instead:

DEVICEHIGH=CASTACKER\STACHIGH.SYS

For other utilities, refer to your manual or contact
the manufacturer for complete instructions.

Additional Boot Disk Instructions

If you have a modem, you can download addi-
tional boot disk instructions from the Sierra Bulletin
Board Service, or BBS. The file to download is
BDALL.EXE or BDALL.ZIP (BDALL.ZIP is compressed—
you will need the PKUNZIP shareware utility to open
it). After downloading this file, select the instructions
that will best match your system and program needs.
In the U.S., the BBS number is 206-644-0112; in the
U.K., the BBS number is (44) 734 304227,

Customer
Service

The best customer service in the industry. “You don’t
just buy our games—you buy the support of the whole
company.”

Sierra On-Line guarantees your satisfaction with
any question or problem concerning our games. Con-
tact the following customer service centers for direct
sales and general game information. In the U.K. and
Europe, use these contacts for replacement CDs and
Technical Support as well.

United States

Sierra On-Line
(For U.S. technical support, see page 21.)

Direct Sales
P.O. Box 3404
Salinas, CA 93912

Call (800) 757-7707
Fax (408) 644-2018

United Kingdom

Sierra On-Line Limited

4 Brewery Court,

The Old Brewery,

Theale, Reading, Berkshire
RG7 5AJ) United Kingdom

Call (44) 1-734-303171
Fax (44) 1-734-303362
9:00 a.m.- 5:00 p.m., Monday-Friday
BBS: (44) 1-734-304227
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France

Parc Tertiaire de Meudon
Immeuble “Le Newton”

25 rue Jeanne Braconnier
92366 Meudon La Forét Cedex

Call (33)1-46-01-4650
Fax (33)1-46-31-7172
Hint line (33)1-36-68-4650

Germany

Sierra Coktel Vision Deutschland
Robert-Bosch-Str. 32
D-63303 Dreieich

Call (49) 06103-994040
Fax (49) 06103-994035

Other Countries

Sierra On-Line
International Direct Sales
P.O. Box 53210
Bellevue, WA, 98015-3210

(Direct Sales and Information Only)
Main: (206) 746-5771
Fax: (206) 562-4223

U.S. Technical
Support

Inthe U.S., contact our Technical Support Depart-
ment for help in installing or configuring your Sierra
product, or resolving hardware or software compat-
ibility issues. You may call, write, fax, or contact us on
our electronic bulletin board service (BBS).

Automated Technical Support

When you call Technical Support at (206) 644-
4343, you can access our Automated Technical Sup-
port line. Available 24 hours a day, this service pro-
vides recorded answers to the most frequently asked
questions. Follow the recorded instructions to find
your specific topic.

Technical Support Representatives

If you are unable to resolve your problem through
the Automated Support line, contact our Technical
Support representatives directly. If you choose to
write or fax us, please provide detailed information
on your computer system and the nature of your
problem. In addition, please include your address and
telephone number should we need to call back or
send you information.

U.S. Technical Support

Sierra On-Line Call (206) 644-4343
Technical Support Fax (206) 644-7697
P.C. Box 85006 8:15a.m.-4:45 p.m.
Bellevue, WA 98015-8506 PST, Monday-Friday
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Technical Support is also available
through:

Sierra Bulletin Board Service (BBS): U.S. (206) 644-0112
or U.K. (44) 734 304227

Internet: www.sierra.com
CompuServe: GO SIERRA

America Online: Keyword SIERRA

Sieirra on CompuServe

Sierra offers technical support and patch files on
its CompuServe forum, as well as product demos,
hints, and reviews. CompuServe members can type
GO SIERRA to reach the forum. To join CompuServe,
call toll-free (800) 848-8199 and ask for Representa-
tive 461 for your FREE introductory membership and
usage credit.

Patch Disks

If you have learned of a patch (update) disk for
yourgame, send in your regquest to the address below,
or contact us on our BBS. When writing, note the
game, version number (VER# on game disk(s)), and
disk type.

Sierra On-Line

Patch Disks

Dept. 10

P.O. Box 485

Coarsegold, CA 93614-0485

The Sierra No-Risk Guarantee!

THE PROMISE: \We want you to be happy with every
Sierra product you purchase. Period. Complete and
return the enclosed ownerregistration card, and we’ll
be able to serve you better. If you're unhappy with
one of our software products for any reason, you can
return it for an exchange or refund within 30 days of
purchase. (If it was purchased retail, please include
the original sales receipt.)

THE ONLY CATCH: You have to tell us why you don’t
like it, so we can improve. If you send it back and tell
us why, we'll do our best to make you happy.

If your Sierra software fails within 90 days of pur-
chase, we'll replace it free of charge. Return the CD
directly to us with a copy of your sales receipt. After 90
days, include the replacement fee: $10.00 in U.S,;
£6.00 in U.K, £7.00 outside U.K. Note: this policy
applies to the original owner only.

In the U.S., send Replacements/Returns to:

Sierra On-Line Fulfillment
P.O. Box 485
Coarsegold CA, 93614

(For Returns, add
ATTN: Returns)
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Limitations on Warranty

UNAUTHORIZED REPRESENTATIONS: SIERRA WARRANTS ONLY THAT THE PROGRAM
VWILL PERFORM AS DESCRIBED IN THE USER DOCUMENTATIONM. NO OTHER ADVERTIS-
ING, DESCRIPTION, OR REPRESENTATION, VWHETHER MADE BY A SIERRA DEALER, DIs-
TRIBUTOR, AGENT, OR EMPLOYEE, SHALL BE BINDING UPON SIERRA OR SHALL CHANGE
THE TERMS OF THIS WARRANTY.

IMPLIED WARRANTIES LIMITED: EXCEPT A5 STATED ABOVE, SIERRA MAKES NO WAR-
RANTY, EXPRESS OR IMPLIED, REGARDING THIS PRODUCT. SIERRA DISCLAIMS ANY
WARRANTY THAT THE SOFTWARE IS FIT FOR A PARTICULAR PURPOSE, AND ANY IM-
PLIED VWARRANTY OF MERCHANTABILITY SHALL BE LIMITED TO THE NINETY (90) DAY
DURATION OF THIS LIMITED EXPRESS WARRANTY AND IS OTHERWISE EXPRESSLY AND
SPECIFICALLY DISCLAIMED. SOME STATES DO NOT ALLOW LIMITATIONS ON HOW
LONG AN IMPLIED WARRANTY LASTS, SO THE ABOVE LIMITATION MAY NOT APPLY TO
YOU.

NO CONSEQUENTIAL-DAMAGES: SIERRA SHALL NOT BE LIABLE FOR SPECIAL, INCIDEN-
TAL, CONSEQUENTIAL OR OTHER DAMAGES, EVEN IF SIERRA IS ADVISED OF OR AWARE
OF THE POSSIBILITY OF SUCH DAMAGES. THIS MEANS THAT SIERRA SHALL NOT BE RE-
SPONSIBLE OR LIABLE FOR LOST PROFITS CR REVENUES, OR FOR DAMAGES OR COSTS
INCURRED AS A RESULT OF LOSS OF TIME, DATA OR USE OF THE SOFTWARE, OR FROM
ANY OTHER CAUSE EXCEPT THE ACTUAL COST OF THE PRODUCT. IN NO EVENT SHALL
SIERRA’S LIABILITY EXCEED THE PURCHASE PRICE OF THIS PRODUCT. SOME STATES DO
MNOT ALLOW THE EXCLUSION CR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL
DAMAGES, SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU.

YOU ARE ENTITLED TO USE THIS PRODUCT FOR YOUR OWMN USE, BUT MAY NOT SELL OR
TRANSFER REPRODUCTIOMS OF THE SOFTWARE, MANUAL, OR BOOK TO OTHER PARTIES
IN ANY VWAY, NOR RENT OR LEASE THE PRODUCT TO OTHERS WITHOUT PRIOR WRITTEN
PERMISSION CF SIERRA. YOU MAY USE ONE COPY OF THE PRCDUCT ON A SINGLE
GAME MACHINE, COMPUTER, OR COMPUTER TERMINAL. YOU MAY NOT NETWORK THE
PRODUCT OR OTHERWISE INSTALL IT OR USE IT ON MORE THAN ONE GAME MACHINE,
COMPUTER, OR COMPUTER TERMINAL AT THE SAME TIME,

This software is protected under federal copyright law. It is illegal to make or distribute
unauthorized copies of this software except to make a backup copy for archival pur-
poses anly. Duplication of this software for any other reason including for sale, loan,
rental or gift is a federal crime. Penalties include fines as high as $50,000 and jail terms
of up to five years.

Sierra On-Line supports the industry's effort to fight the illegal copying of personal
computer software. Report Copyright Violations To:

SPA, 1730 M Street N.W. Suite 700,

Washington, D.C. 20036 - (202) 452-1600

This manual, and the software described in this manual, are copyrighted. All rights are
reserved. No part of this manual or the described software may be copied, reproduced,
translated or reduced to any electronic medium or machine-readable form without the
prior written consent of Sierra On-Line, Inc. 3380 146th Place SE, Suite 300, Bellevue,
WA 98007,

® and TM designate trademarks of, or licensed to Sierra On-Line, Inc. ® Sierra On-Line,
Inc. 1995. All rights reserved. Printed in the USA. IBM®, PC® are trademarks of Interna-
tional Business Machines Corporation. Microsoft®, MS-DOS®, Windows™, HIMEM™,
Windows 95™, are trademarks of Microsoft Corporation, Sound Blaster® is a trademark
of Creative Labs, Inc. Stacker® is a trademark of Stac Electronics. Sound Ideas is a regis-
tered trademark of the Brian Nimens Corporation, Lid.

Some scund effects used in this product were derived from the Sound |deas® sound
effects library. For more information, Sound Ideas can be reached at:
U.5. (BOD) 387-3030; Canada (800) 665-3000; (416) 886-6800 Fax



